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OL PlanetPress Connect Release Notes 2023.1
License Update Required for Upgrade to OL Connect 2023 .x

From OL Connect 2019.1 onwards, only customers with a current OL Care subscription will be able to
update Connect.

Every Connect license now contains an end date that represents the last day of OL Care coverage for
each customer. Upgrades and updates of Connect will be freely available up until that end date, but will
not be available thereafter, unless the OL Care period is extended.

This new licensing model requires anyone upgrading from Connect versions earlier than 2019.1 to first
update their OL Connect License.

A dialog box appears as part of the Connect upgrade process requesting you to do this.

It is heavily recommended that you first update the OL Update Manager, as newer versions of the
Update Manager can update your OL License to the required version, then install Connect 2023.1.

For further details on how to upgrade the Update Client and update your Connect License see the
Update Manager 1.5 - Upgrade Guide.

Ifissues arise, or if you need to renew your OL Care subscription, please contact your local Customer
Care group.

Backup before Upgrading

It is recommended that you always backup your existing Connect preferences before upgrading to a
new version. This will enable you to revert back to the previous version, in a worst case scenario in
which the new version introduces issues with your existing production processes. Whilst the probability
of such a worst case scenario is remote, it cannot hurt to take some simple precautions, just in case.

For instructions on how to do so, please see how to backup an existing Connect installation.

Overview

This document provides an overview of the new features and enhancements in PlanetPress Connect
2023.1 and PlanetPress Workflow 2023.1, as well as some important installation information.

Installing OL Connect 2023.1 and Workflow 2023.1

» PlanetPress Connect is released as a 64 bit version only (with the exception of the Workflow,
Fax, Search and Imaging modules).

« Full details on installing and licensing PlanetPress Connect and PlanetPress Workflow can be
found in the online help, which can be accessed from the software and the installer.
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http://help.objectiflune.com/en/archive/Update_Manager_1.5_Upgrade_Guide.pdf
https://www.objectiflune.com/WebActivationManager/CareInfo.aspx
https://www.objectiflune.com/WebActivationManager/CareInfo.aspx
https://help.uplandsoftware.com/objectiflune/en/planetpress_connect/2023.1/Installation/Backup_Existing_Connect_Version.html

Connect and Workflow installers require Administrator rights

Please note that the PlanetPress Connect and PlanetPress Workflow installations can only be run by
users who have Administrator rights.

Connect Templates Used in Workflow

For improved performance we recommend re-saving any Connect templates used in Workflow to the
current version of Connect templates.

Reduced Memory Version (not recommended for production)

It is possible to install OL Connect on a machine with a minimum of 2 GB of RAM. The Connect
Designer will automatically detect whether it has been installed on a machine with less than 4 GB of
RAM and default to only using one internal Weaver and one internal merge engine on that system. The
Server will also run using internal engines.
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OL Connect 2023.1 Improvements
Welcome Screen improvements

A completely redesigned Welcome screen now allows you to perform the most common tasks from a
single place.

The overhauled New section not only lets you create new documents but also download online
resources.

Selecting an online resource shows a short description explaining its use case and detailing the tech-
niques it uses. That information may even include links to how-to’s, blog posts or pages in the online

File Edit Window Project Help
0 e @
{0} Welcome x @ e
"
OL’ Connect Qo support  Software activation
Print  Web Email Data Project Presets
Home Bundle Offer letter
Print templates L
New Resource by Upland Objectif Lune
Open This letter contains enticing details about a product
D andror services. A conditional paragraph shows a
special promo for customers in a specific provice. An
Q Learn office location is dynamically shown based on the
Blank template PDF based Word based province of the recipient. Updates the name and
[ Community Create an empty Use a PDF file as your Use a Word flle as your signature of the sender.

print template starting point starting point
Replace the stationery image with your letterhead

online Hel y
® P and update the formatting to match your corporate
identity.
Online resources .
e Start typing to filter Key features
Suggested searches:  Labels nveices Cards Letters %

* Page size: Letter

® Address block of

* Dynamic 'office’-locations &
« Conditional paragraph

« Dynamic signatures

Printer configurations

Finishing configurations

@ My license s Virtual stationery
>
eato¥*
Basic postcard
o e v

The new Learn section shows our most recent blog posts and lists the most popular hands-on tutorials
and how-to’s. It provides access to a central repository of OL Connect content, including sample files,
example projects, tutorials and blog posts.

The blog posts provide information about new features, tips and techniques to increase productivity
and the tutorials introduce basic features of OL Connect for those just getting started.

All this brings OL Connect related knowledge right to your doorstep.

MariaDB update

Updated the MariaDB which is installed with Connect to version 10.11.2. (89330)
Java update

Updated the Java platform which Connect runs on to Adoptium Temurin 17.0.6. (87357)
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General Connect Improvements

e Better support for MS SQL Server backend databases. Retry code was added to work around
deadlock issues. (87653)

» The database vendor and version are now included in the logs when the database connection is
first made. (87325)

« Improved error messaging and localization. (88060)
» Fixed a session data memory leak issue in Connect Server. (88768)

» Old copies of the JavaSysMon native library (DLL) that were previously left behind after a Con-
nect product had run, will now be cleaned-up at next product start-up. (89361)

Security improvements
» Connect dependencies have been updated to recent versions. (87357)

» Improved user account validation when testing credentials for Connect service, in Connect
Installer. (88547)

Installer Improvements
» Installer language selection is now localized. (86625)

* We have altered the setup so that it is more robust. (86520)
Changes include:

* When a user enters “Username”, we make the assumption that the user really means
‘HOSTNAME\Username”

* When a user enters “\Username”, we make the assumption that the user really means
‘HOSTNAME\Username”

REST API Improvements
* The All-in-one (print) operation can now return produced xxxSetlD(s). (83620)

» Added the ability to restrict searches to a discrete set of DataSets, ContentSets or JobSets.
(88249)
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OL Connect 2023.1 Designer Improvements
Job and Output Presets improvements

Job and output presets handling is changed from storing them in Connect Designer’s workspace, to
dealing with them as regular files that sit in a folder under your control. This way, job and output presets

can be managed alongside templates and data mappers that belong to the same project or customer.
(88926)

The Print and Proof Print dialog have been simplified to make them less cluttered, and simpler to use.
They now provide plentiful ways for selecting, opening, editing and saving job output presets. (88903)

c| Proof Print E
Job Preset: | <Last Used Settings> v]e 2
<Default>
ACMENACME_Marketing_Run.OL-jobpreset
Output Preset: | <Last Used Settmis:\ = #
Property Value
4 Qutput Settings
» QOutput Model Name Generic PCL Finish
Qutput to Prompt for File
> Inserter Pitney Bowes - DIS00/DI950 Barcode (Tower)
» Booklet Binding Saddle Binding
» Impositien 2Up A4
Seftmask Conversion Methed Basic
4 Job Creation
Data Selection Filter Enabled
Sorting Standard Sorting
Runtime parameters

Added job and output preset items to the File>New wizard, so you can create presets in the same way
as templates and data mappers. (88618)

c| New... = =

Select a wizard —_— <

Create a new Output Preset |

Wizards:

type filter text

» (= Data mapping Configuration
» [ Data mapping Wizards
4 = Presets

[ Job Preset

“ Output Preset

» % Sample projects

Job and output presets can now be opened for editing directly from the “Project files® view. (88615)

Presets are now handled as regular files in “Send to Workflow*, “Send to Server®, or “Package” options.
(88922)

c| Package

Cenfigurations 3
51 ACME_Letter.OL-template

[} Promo-EN.OL-datamapper

[i1f] ACME_Marketing Run.OL-jobpreset

m ACME_Marketing_SE_Australia. OL-outputpreset
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Barcode Improvements

» Barcode properties can now be added at the time of barcode insertion, rather than afterwards in
the Barcode properties dialog. The barcode insertion dialog is now split over three tabs, Insert,
Properties and Output. (87729)

a Insert Barcode | < JINC Insert Barcode B
Insert | Properties | Output Insert | Properties | Qutput
Barcode General
Type: OR Code v Preferred Version: 1 v
Field: Email v [¥] Auto Configure
Module Size: 4
Selector
o po— Encoding: Auto v
: arcode
Class: ECI: Mone v
o Correction Level: L v
Insertion Point
[ Absolute FNG: No hd
Location: | After element v
Elements: | h3 v Scale: Nene b
Process Tilde
@ Cancel @ Concel

» The guardbars and human readable message are now always enabled for new barcodes, with
the human readable text present at the bottom of the barcode. This is the case for all new UPC-
A, UPC-E, EAN8 and EAN13 barcodes. (45352)

a Insert Barcode H

Insert | Properties | Qutput
General

Medule Width: 0.03

Scale: None v

Supplement

Type: Auto detect v
Height Factor: 0s
Space Before: 05

Human Readable Message

Font: Arial v
Size: 8 v

» Updated the barcode properties dialog for the GS1 Datamatrix Barcode properties, showing the
correct properties for the barcode. (67410)

a Insert Barcode “
Insert | Properties  Qutput
General
Dots Per Pixels: 4
Preferred Format: Auto detect w
Scale: MNone w

Process Tilde
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» Improved the validation of the Application Indicator property for QR codes. The Application Indic-
ator is only used for the QR code, when FNC is set to Second, otherwise it's disabled. (85682)

* When a barcode is added to a section that has Handlebars expressions enabled the Designer will
now add a Handlebars expression instead of creating a script. (87735)

ACME marketing letter

{{~Brand~}}

Windows Scaling improved

Improved support of high DPI monitors in the Designer. Users with high DPI monitors typically use the
Windows scaling feature which we have improved support for. (88412/89295)
Other fixes include:

» Dragging a data field onto the editor while holding the CTRL-key would insert the box in the
wrong location. (86740)

e The helpers for dragging and resizing absolute positioned boxes were shown in the wrong loc-
ation. (88406)

* The rulers on screen were set to the wrong size. Also dragging of guides would not follow the
mouse correctly. (88428)

Improved handling of missing images

Several improvements were made. (87678)
These include:

e Thedata-broken-image attribute is added tothe <img> element to specify that the
image could not be found.
This can be used in the selectors in scripts and CSS to apply custom styling or to insert a fallback
image.

e Provide Alternative text (<img src="" alt="">)viathe Attributes panel. When specified, this
text will be rendered in the output in case the image cannot be found.

* No longer show a red cross for broken images in print output. We only show a red cross in design
or preview mode in the Designer, and we only do this if the a1t attribute is not present.

Improved Microsoft Word importation

When creating a new template based on a Word document, mail merge placeholders are replaced by
handlebars expressions or @-placeholders depending on the Evaluate handlebars expressions setting
on the active section. For example «foo» will now be replaced by {{foo}}. (89117)
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Improved Versioning

Several improvements were made to Versioning. (88627)
Specific improvements include:

» Improved Project view. The option to “Reveal in File Explorer’ has been introduced for the selec-
ted item in a versioning project. (88611)

* Numerous useability options are now available in the project file’'s context menu. (88643)

» Standardize icons in Project Menu. (88632)

General Designer Improvements

Introduced simple way to see what data file is currently in use and to swap to another. (77490)

|| Data Medel | (] Parameters o = B @ g ~EF = B
type filter text |E| Prome-EN.csv I

record [1001 D

Mame Value ]

* Removed warning about missing <br> after replacing source and switching back to Design
mode. (78852)

* In some scenarios the src attribute of an <img> element could be converted to an absolute path.
This has been fixed. (82049)

» Fixed an issue with the positioning of proportionally scaled SVG barcodes. (88380)

¢ Added a column to the text script wizard and the text helper wizard to make it easier to add a line
break to a script entry. (88509)

a Edit Script - o
MName: Text Script
Find text: | @Brand@

(O)Selector (@) Text () Selector and Text

Prefix Field Format Suffix
abe StreetAddress] v Mene
abe Streetfiddress? v MNone
abe City v Mene

T+

tt

abe Zip v MNone
abe State v Mene
abe Country v MNone

€ £ € £ € £
R =

» Selecting text in an absolute positioned box is now contained to the box itself. (87477)

» The defaults for widows and orphans for tables now set to 1 so that small tables with tall rows are
automatically paginated. (89076)
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» Added new Text Alignment option of Default html which disables the text alignment options in the
Dynamic Table Wizard. This allows you to style the text alignment of the columns yourself.
(87214)

a Insert Dynamic Table = B

Dynamic Table Builder
Specify the Rows and Fields for the Dynamic Table.

~  Table: detail Ty &~
% Row detail v Class R SER R
{ Field |-\h‘ ItemMumber v‘ Format ‘None v| x }
{ Field |-\h‘ ItemDesc v‘ Format ‘None v| x }
{ Field | % ltemUnitPrice v‘ Format ‘Currency v| x J
{ Field | # ltemOrdered v‘ Format ‘None v| x J
{ Field | # ltemShipped v‘ Format ‘None v| x J
w

|Taxt alignment:

] |-ij-usein|me;ty|es () Use €SS utility classes

@ < Back Next > Cancel

¢ Anew Type tab has been added to the Box Formatting dialog. This allows you to apply text
formatting styles on the text within a box. (87718)

[c] Box Formatting “
Box Background | Spacing | Border | Content | Type
General Style
Font: Tahema v []Bold
Itall
Size: 12pt Ditatic
[[] Underline
Color: rgbi0, 0,00 v | [ strikethrough
Spacing [] Capitalize
Letter Spacing: | normal O Uppercase
Word's o [ Lowercase
ordapacing: | e []Small-caps
Whitespace: normal v
@ Advanced Apply Cancel

» The collapsed and expanded state of folders in the resources view is saved with the template.
When the template is opened (on a different machine) the resources view is restored. (87738)

» Handlebar templates can now use the following data variables: (87687)
e -Q@first:this variable is true when the current record is the first of a data set.
e -@last:thisvariable is true when the current record is the last of a data set.

¢ - @index: this variable contains the zero-based index of the record within its data set.
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» Fixed issue with opening CSS files that contain extremely long strings. (87251)

» Fixed an issue in script wizards with the Field drop-down becoming unresponsive after selecting
a runtime parameter. (88171)

* We no longer log an error when the resource function is used to check the existence of an HTML
snippet (or any other non-image file). (87958)

» TextHelpers now have a Data scope which affects the fields that are available in the field column
in the entries table. The Data scope allows text helpers to be used in detail tables with the same
scope. (88282)

» Designer now remembers the state of resource panel in Templates. (88596)

» Fixed an issue with field names containing periods in text script wizards. (88825)

» Fixed an inconsistency with script profiling results. (88887)

* You can now turn a static table into a dynamic table through the Attributes panel. (88907)

» The defaults for widows and orphans for tables are now set to allow small tables with tall rows to
be automatically paginated. (89076)

« In Handlebars mode, field names containing special characters are now escaped when they are
dragged to the main editor. (89096)

» Support was added for Handlebars partials in the main (HTML) content editor.
For technical reasons the implementation slightly differs from the partials in Handlebars snippets
and uses the plus (+) sign instead of the greater than (>) sign ({ {+snip-
pets/officelocation.hbs}} or { {+officelocation}}). (89301)
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OL Connect 2023.1 DataMapper Improvements
Improved Data Model filter

Improvements include (87773)

+ The Data Model panel now has the same appearance as the filter options shown in the Scripts
panel and the Resources panel.

» The filter now operates on either field or table names as well as field values.
JSON Improvements

« Add Repeat action now automatically sets the name of the data table to the name of the property
so that you don't need to manually change this from 'detail' to the name of the property. (87705)

» Implemented support for JSON key nodes with spaces. (88571)
File Extraction Improvements

» Extra tooling added to LincPDF to assist in identifying issues with conversions from PCL to PDF.
(86810)

» Handling of PDF files with incorrect TrueType font data has been improved. This improves data
mapping of certain PCL files that are converted to PDF using the Connect LincPDF tool. (86936)

» Fixed an issue with data extraction from PDF files that feature an unusual Unicode font encoding.
(88560)

» Fixed an exception with PostScript input on machines with more than 8 cores. (88603)

» Extend Fontmap format and look for user-supplied Fontmap files in PDF resources folder.
(88997)
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General DataMapper Improvements
» Improved Save option in DataMapper JavaScript dialog. (80018)

» The Validate all records option has been enhanced to display a table of all operations performed
and the time spent in each step. This allows you to identify the steps that consume the most time
and that could therefore be candidates for optimization. (86657)

..........

[i Orderfumber: (INV1369443)
<“CustomerPO> (579699)
[] <CustomerNumber:> (CU32859357)
Main record SalesRep> (Ed Biasi)
= N RN =i {2816 63 07 A
[ Al records are valid X
[]
ltem loop Steps performance  Detected problems
'%g Time(%)  Step Calls Max time in record
L) 60% Main record (Extract) 50 5346 us #7
Cheg Cty 1% ltem loap (Laop) 217 6pus #7
& — ? — 10% Extract ftem (Extract) 49 g3ps w2
i 6% Check Oty (Condition) 167 Tops  #7
Extract item
o
| ® e
I “Shipped> (2)
<BackOrder> (@)
r— <Totals (20.78)
x v <Product> (9 9 9 9
I <Number> (148080
Description: (Swix Alpine Racing Strap:
W ‘UnitPrice> (9.99)
<0Ordered> (2)

<Shinned: 2}

* Changed the behavior of the File Browse dialog in DataMapper wizards, so they now default to
the last selected location. (88164)

» Improved scaling of tables when using high Windows DPI settings. (88410)

» Implemented check for infinite loop in DataMapper script engine. Any script with an infinite loop is
canceled after the time set in Preferences->DataMapper->Timeout option. (88421)

c| Preferences - O
type filter text DataMapper oo - 3
General Commeon DataMapper preferences
Clean-up Service
4| DataMapper | Timeout for individual steps (in seconds): |13 = |
DataMapper XML
Default Format
Database Connection
i

» Boundaries control width are now properly framed when changing to On Text boundary. (88527)
» Fixed issue with MySQL connections from script engine. (88622)

e Support non-UTF-8 font names in PDF files by extrapolating the encoding from the font's CIDSys-
temlnfo if the font name is not valid UTF-8. (89035)
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OL Connect 2023.1 Output Improvements
Added Support for Banner Pages

You can now incorporate banner pages to print jobs. (88372)

a Output Creation = =
Separation Options

Use this page to select the separation options

Separate by Count
split: None

1000 2] Sheets

Separation Settings

Separation: | Nene

Banners

Every:

Slip Sheets
Add slip shest:

You can also add custom information to the banners, to better support print production processes.

< Additional Text Ex

General

[¥Include in output

on: | Banner Page

Orientation: | Portrait | [¥]Qutput once per sheet

Left: 1in Bottom: Tin

Font

Font Name: | Arial v| FontStyle  Regular v

Font Size: 10

Color: [Mbiack Bl |
Text: Banner Page B
Conditi page.banneq 3
@ Conc

General Output Improvements
» Relaxed the validation rules when using a file mask to allow embedded JavaScript. (74168)

» Fixed "image optimization" triggering an exception when encountering Separation- or DeviceN-
color images in background PDFs. (87701)

» The formatting of operation duration values in a print summary will no longer cause a job to
potentially fail when a duration value is reported as being negative. (87999)

» Fix crashes on DeviceN colorspaces with NChannel information on some but not all of the color
components. (88640)
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Print Output Improvements
» Enabled transparency for PPML output, so content is no longer flattened. (87148)

» Support has been added to allow external sorting in job creation based on the document sheet
count. (89121)

Email Output Improvements

» Fixed an issue where the style element containing media queries or font face definition could end
up in the body of an email instead of the head. (83002)
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Workflow 2023.1 Improvements
Security improvements

e Add support for TLS 1.3 (89124)

» Security vulnerabilities were fixed. (86169)

As part of this effort, support for Novell NetWare has been removed.

» Other Workflow 3rd party libraries to latest versions. (86999)

e OpenSSL 1.1.1tis now the default openSSL library used by Workflow helpers and plugins.
(88782)

Memory leaks fixed
* Memory leaks were fixed in the plugins used for OL Connect Send solutions. (57329)
» Fixed a memory leak in processes using local variables. (87193)
* A memory leak was fixed in the Workflow custom plugins framework. (87911)

» A problem was solved where a Folder Capture plugin configured to use regular expression and
sort on either creation of modification date was leaking system handles. (87972)

* Memory leaks have been greatly reduced when using self-replicated processes, and elim-
inated when those processes don't use AlambicEdit. (88362)

Several further memory leaks were fixed in specific plugins. The plugins affected are:

e The suite of OL Connect plugins. (87464)

 The PDF Splitter. (88083)

» The Create Web Content plugin. (88206)
General Workflow Improvements

* In the PDF preview window, it is now possible to browse up and down using the Page Up/Down
keys. (82507)

* A Create PDF problem was fixed where PDF keywords were duplicated when they were mod-
ified. (84362)

e Input SFTP/FTPS plugin - When plugin is created, the default mask is now setto “* . **, (87886)

» Fixed deadlocks and potential data loss events when the Telnet Input server is under heavy
load.
Fix also cleans up the logs by grouping lines together per connection. (88203)
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» Job creation options set to 'None' in the All in One plugin were not being handled properly when
running in a language other than English. This has been corrected. (88239)

« Improved plugin File Store - Upload File. Different resource files can now be uploaded. (88284)

* You can now specify dynamic values in the connection parameters for all Office 365 plugins by
using variables and data selections to populate those fields. (88289)

| Properties
Microsoft 365 Email Dutput \=\:)
Allows emails to be eend on behalf of any uger in the organization's Microsoft 365 > i
accounts.
General
Enter text.. -
Attachments Files
Select file or folder to use for condition Browse Add
| S |
—Connection
Application 1D

Application 1D
Application Password
Application Password
Tenant ID

Tenant ID

User ID

User ID

Use delegated permissions
User Password

User Password

Allow dynamic fislds

ok | Cancel ‘ Help |

» Refined the validation for the mail host port in the Create Email Content plugin, so that it now
accepts all valid TCP ports. (88321)

» Fixed “Sort By Name” issue for duplicated names in the Configuration Components pane.
(88445)

« Queries with a large amount of parameters can now be allowed by modifying the parameterLimit
value of the server. (88651)

» Office 365 email output plugin now allows HTML formatted email messages to be sent. (88778)
» Expanded Workflow variables are now supported in XSLT script files. (88963)

» Fixed a WinQueue Input issue where capturing print jobs in EMF format would cause access
violations when polling print queues for jobs to capture. (89157)
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» File Store - Upload File task now has a File type selection which can added in the task descrip-
tion and hint. (89180)

Properties “
File Store - Upload File
Uploads a file ta the Connect File Store @

General I 0L Connect Prosy | On Ermor | Mizzellansous

Filenarme
Jt

File type

Template ;I

D ata file
D ata mapping configuration

Output preset
Job preset
Auto-Detect

Save File Store 1D in variable

| El

o HTTPS forwarding is now properly made for non localhost URLs. (89198)
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Known Issues

As of PlanetPress Connect 2018.1 the Known Issues have moved from the Release Notes to the Con-

nect online Help.

They can be found here.
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https://help.uplandsoftware.com/objectiflune/en/planetpress_connect/2023.1/Installation/Known_Issues.html
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